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HealthTracker

Communicare can be integrated with The George Institute HealthTracker™, a decision support
system developed by the researchers at The George Institute for Global Health to assist primary
care health staff in best practice management and prevention of cardiovascular disease, diabetes

and chronic kidney disease.

Clinicians can use the Communicare HealthTracker to generate an interactive health risk
assessment which shows recommendations based on guidelines. They can demonstrate to patients
how reducing a risk factor such as smoking can affect that patient's risk and provide tailored advice
to patients to assist with the management and prevention of cardiovascular disease, diabetes and
chronic kidney disease.

The interactive report uses the qualifiers and measurements recorded in the George Institute

HealthTracker clinical item.

There is no cost to Communicare sites for the implementation, training and use of the

HealthTracker™ tool.

Healthtracker details

Cardiovascular Risk is calculated using the Framingham Risk Equation and Diabetes Risk is
calculated using the AUSDRISK™ tool.

Recommendations from current Australian guidelines are incorporated into a single algorithm to
provide tailored management support. The following guidelines have been used in the development

of the HealthTracker™ algorithm:

« National Vascular Disease Prevention Alliance Guidelines for the management of absolute
cardiovascular risk (2012)

- National Heart Foundation Guide to the management of hypertension in Adults (2016)

« National Heart Foundation Reducing risk in heart disease: an expert guide to clinical practice
for secondary prevention of coronary heart disease (2012)

« National Heart Foundation/Cardiac Society of Australia and New Zealand Guidelines for Atrial
Fibrillation (2018)

« Royal Australian College of General Practitioners Management of type 2 diabetes: A handbook
for general practice (2020)

« Royal Australian College of General Practitioners Guidelines for preventive activities in general
practice 9th edition (2018)

« Kidney Health Australia Chronic Kidney Disease Management in Primary Care 4th edition
(2020)



« Australian Stroke Foundation Clinical Guidelines for Stroke Management (2020)
« 2018 NACCHO/ RACGP National guide to a preventive health assessment for Aboriginal and

Torres Strait Islander people

HealthTracker™ has been extensively evaluated in a large cluster randomised controlled trial
involving 40 General Practices and 20 Aboriginal Community Controlled Health Services in NSW
and Queensland. It was associated with improvements in guideline-recommended screening

for CVD risk and improved prescribing, particularly for people at high CVD risk who were not
receiving guideline-recommended medications, see https://www.ahajournals.org/doi/10.11671/
CIRCOUTCOMES.114.001235. The intervention was also found to be highly cost effective, see
https://www.mja.com.au/journal/2020/213/2/computer-guided-quality-improvement-tool-primary-

health-care-cost-effectiveness.

HealthTracker data privacy and security

The George Institute has strict privacy requirements for handling data and fully complies with the
Australian Privacy Principles and laws. Deidentified data is securely sent to The George Institute’s
servers, which are located within an ISO 27001 certified data centre in Sydney. The servers process
the data through the HealthTracker™ rules engine to generate the results. No data is retained by The

George Institute at the completion of this process.

HealthTracker training

Training in how to use the George Institute HealthTracker™ will be conducted by The George Institute
remotely, ideally in small group sessions. Training must be completed before the George Institute

HealthTracker clinical item is enabled for your site.

Information describing the HealthTracker™ included by Communicare is an overview only. More
in-depth information about the functionality and use of the HealthTracker™ will be covered in the

training provided by The George Institute.

For an overview of the George Institute HealthTracker™ in Communicare, see https://youtu.be/
FSumkO2IF4c.

Enable HealthTracker

After your site has completed training in how to use the George Institute HealthTracker™ tool,

configure HealthTracker integration in Communicare.

About this task
Configuration must be completed by a Communicare Administrator.


https://www.ahajournals.org/doi/10.1161/CIRCOUTCOMES.114.001235
https://www.ahajournals.org/doi/10.1161/CIRCOUTCOMES.114.001235
https://www.mja.com.au/journal/2020/213/2/computer-guided-quality-improvement-tool-primary-health-care-cost-effectiveness
https://www.mja.com.au/journal/2020/213/2/computer-guided-quality-improvement-tool-primary-health-care-cost-effectiveness
https://youtu.be/FSumkO2lF4c
https://youtu.be/FSumkO2lF4c

Procedure
To enable the HealthTracker dataset in Communicare:

1. Enable the George Institute HealthTracker dataset:
a. Select File > System Parameters > System tab.
b. In the Datasets section, set George Institute.
c. Click «#"Save and enter the daily authority code provided to you by Communicare
Support.

2. Enable the George Institute HealthTracker Dataset in Communicare:
a. Ensure that no-one is using the Communicare server or clients.

b. From the Communicare installation folder, run CCCent r al Dat aUpdat e. exe.

6 Tip:

The central database can be found at C: \ Dat a\ CENTRAL. f db.

3. The HealthTracker report references a number of family history clinical items. Add the
following clinical items to File > Reference Tables > Clinical Item Types if they do not already

exist, using the following values:

i
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Table 1. Family history clinical items referenced by HealthTracker

Formal Terms Topic Export Code

FH: Chronic Kidney Disease Ur ol ogi cal FH- CKD

FH: Diabetes Mellitus Endocrine, Metabolic and FH- DI AB

Nutritional

FH: Cardiovascular Disease <60 | Car di ovascul ar FH CVD

FH: Myocardial Infarction 45-60 | Car di ovascul ar FH- M 45+

FH: Myocardial Infarction <45 Car di ovascul ar FH-M 45-

FH: Myocardial Infarction >60 Car di ovascul ar FH M 60+

For all clinical items, ensure the following fields are also set:




« Natural Language - use the value used in Formal Terms
*Class-settoHistory
« Viewing Right - set to Conmon

« Set Summary, Date only, Enabled

Results
The HealthTracker dataset is enabled.

Communicare Support configure the integration settings. To view the settings, select File >
System Parameters > HealthTracker tab. Do not change these settings unless instructed to by

Communicare Support or our technical teams.

What to do next

Note:
Addthe R sk Dial Wb Servi ce URL as a Trusted Site to each user's internet browser

settings.

George Institute has assigned rulesets to Communicare on the HealthTracker Service Platform
which is available for integration and consumption. It has input and output requirements, all
accessible using the same Service API. The health assessment result is available to Communicare

for users to interpret and can also be saved as part of a patient clinical record.

Use HealthTracker

When HealthTracker™ configuration is complete, clinicians can add the George Institute

HealthTracker clinical item to a patient clinical record and generate a HealthTracker™ report.

About this task

( o
Note:
By using George Institute HealthTracker clinical item, the user is bound by the George
Institute terms and conditions of use. To read the full terms and conditions, in the George
Institute HealthTracker clinical item, double-click the red disclaimer text at the top of the

window.

N

In Communicare, the George Institute HealthTracker clinical item can be used in the same way as

any other clinical item.

Procedure
To add the George Institute HealthTracker clinical item:



1. In Communicare, in a patient's clinical record, click i==Clinical Item.

2. In the Clinical Terms Browser, in the Search-words field, enter Geor ge and select George
Institute HealthTracker.

3. In the George Institute HealthTracker clinical item, double-click the red disclaimer text at the
top of the window and read the terms and conditions of use.

4. Complete the information on the HealthTracker tab or section.

6 Tip:
Information on the other tabs is provided by The George Institute after a patient's
information is sent to them.
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To provide the most accurate report the following qualifiers and data elements are required:




* Items required for the CVD risk calculation:
> Age
o Sex
> Total cholesterol
o HDL
> Blood pressure
> Smoking status
« For other HealthTracker™recommendations, also include:
o Aboriginal or Torres Strait Islander status/ethnicity
> Weight, height
- Diabetes-related risk factors, such as, Albuminuria (ACR), Fasting blood glucose,
HbA1c
o CKD-related risk factors, such as, Creatinine
o CVD-related risk factors, such as, LDL, Triglycerides
« Other relevant history:
o Past medical history
> Medications
> Family history recorded in the following Family History clinical items:
= FH: Chronic Kidney Disease
* FH: Diabetes Mellitus
» FH: Cardiovascular Disease <60
* FH: Myocardial Infarction 45-60
* FH: Myocardial Infarction <45
» FH: Myocardial Infarction >60
When adding information:
* The latest recorded qualifier measurements are displayed in red text next to the data
entry field. Enter new measurements in the input fields during a service.
« If a new qualifier measurement is not added, Communicare sends the latest existing
qualifier measurement to the HealthTracker system for inclusion in the report.
5. When you have provided sufficient information, at the bottom of the clinical item, click Send to

George Institute.

Results

The data you provided is sent in an encrypted form for analysis by the HealthTracker™ algorithm.

Based on the patient’s qualifier measurements, history, biographics, medications and conditions,
the HealthTracker™ produces an interactive report and displays it in the default browser. The report
may take several seconds to generate, and the Communicating with George Institute window is
displayed until the results are returned.



. N
Note:
To interact with the HealthTracker tool, the patient sex must be set to either male of female.
If sex is set to anything else in the patient biographics, a warning is displayed when you

attempt to generate the report from the clinical item.
- J

Error and warning messages may be encountered when submitting the clinical item to George
Institute HealthTracker service. Below are the types of messages a user can receive as part of the

submission:

« Error 101 - shown when the service encounters an error while accessing the database

« Error 102 - shown when the service encounters an error while accessing the George Institute
HealthTracker Service

« Error 103 - shown when the service encounters an error related to data validity and when the
service response status code is non-200

« Error 104 - shown when the required settings for George Institute HealthTracker Service are
not set

« Warning - shown when the value of an input qualifier falls outside the valid range

What to do next
Review the report. The report can be used interactively: demonstrate to patients how reducing a risk
factor such as smoking can affect the patient's risk and provide tailored advice to assist with the

management and prevention of cardiovascular disease, diabetes and chronic kidney disease.

If required, based on your review, edit the output qualifier fields and add notes or additional
information before saving the clinical item. The returned results become part of the clinical item
record for the patient. Details are also saved as a progress note.

Note:

The progress note is the only record of what was displayed in the HealthTracker™ reports.

No data is kept by The George Institute after the report is closed.

Review HealthTracker report

The George Institute HealthTracker™ displays results for a patient in the default browser.

Use the interactive graphical display to explain to patients their cardiovascular, diabetes and kidney
disease risks. This allows the patient and health professional to assess current and projected risk
and to perform "what if" scenarios. For example, the effects on future risk if the patient can stop

smoking, and so on.




On all tabs, the recommendation status is displayed using traffic light colours:

« Green - the measurement or findings are in the normal acceptable range

« Orange - the measurement or findings are above the normal acceptable range. This serves as
a warning and should prompt recommendations.

* Red - the measurement or findings are on high and should be acted on

* Blue - the measurement or findings are unknown or an assessment or recommendation can't
be provided

Summary
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The Summary tab displays the following information for the patient:



« An estimated 5-year CVD risk percentage and recommendation.

« Current CV medications.

« CV-related medical conditions both past and family history related conditions.
« Current smoking status and recommendation.

« Current weight related data and recommendation.

« Current blood pressure related data and recommendation.

« Current cholesterol related data and recommendation.

« Current kidney related data and recommendation.

 Current diabetes related data and recommendation.

Risk
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The Risk tab presents the estimated cardiovascular disease risk for the patient.



Adjust the risk factors such as Age, SBP, Cholesterol (LDL), HbA1c, Smoking status and Diabetes
and observe the impact on a patient's risk percentage and any associated recommendations. The
risk dial sliders for SBP, Cholesterol (LDL) and HbA1c qualifiers can only be lowered.

Conditions are also implied to control the behaviour and value of each qualifier. The availability of

the sliders for each qualifier depends on other qualifier values:

* Age
> The range should be from 30 to 90 years
o If patient has CVD or a clinically high-risk condition, slider should be disabled.
« Systolic BP
> Only enable when SBP is above 110mmHg
> Show current value as upper limit
« Cholesterol (LDL)
> Only enable when LDL is above 1.5mmol/L
o Show current value as upper limit
« Smoker
o This is a simple on and off slider
> Only enable when the patient is a current smoker
« Diabetes
o This is a simple on and off slider
> Only enable when the patient has diabetes
* HbA1c
> Only enable when the patient has diabetes and HbA1c is above 6%

> Show current value as the upper limit

Diabetes
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The contents of the Diabetes tab depends on whether the patient has Diabetes or not.

- If a patient has diabetes, the Diabetes management page shows the diagnosis record and any
recommendations including medicines that will help in managing the diabetes level. It also
includes recommendations for:

o Retinopathy

> Foot Assessment

o Foot Risk Calculator result
> Neuropathy

« If a patient has not been diagnosed with Diabetes, the Diabetes screening page is displayed
which describes the patient’s diabetes risk, screening results and the relevant AUSDRISK
points. It provides a 5-year diabetes risk calculation and recommendation. It also includes the
following information:

> Diabetes Screening recommendation

> Diabetes screening results



> Diabetes risk points which are based on the following criteria:
= Age
» Gender
= Aboriginal and Torres Strait Islander (Australia)
= Birthplace
= Family history of Diabetes
= Family history of High blood glucose
= High Blood pressure medication
= Fruits and Vegetable consumption
= Smoking status
= Physical exercise
= Waist measurement

Lifestyle
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The Lifestyle tab describes the patient’s lifestyle and provides recommendations about smoking
status, diet, and physical activity.



Tests
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The Tests tab describes the patient’s latest blood pressure, kidney, cholesterol and HBA1C test
results and the recommended follow up test date.

Medicines
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The Medicines tab describes the recommended medications based on the patient’s conditions and

qualifiers, related to the following:

* Blood Pressure - assessment for BP lowering is done based on patient's current medication
related to BP.

« Cholesterol - assessment for Statin, Fibrate, Target LDL and Target HDL are done based on
patient's current medication related to Cholesterol.

« Antithrombotic - assessment for Anti-platelet and Oral anti-coagulant are done based on
patient's current medication related to HbA1c.



Support

If you run into problems using Communicare, you can always get help from us.

For information about Communicare, visit the Communicare User Portal. If you need more help, go

the Communicare User Portal - Help and Support tab.
If you still need help, create a support request and we'll get back to you.

Include as much information in the request as you can and follow these guidelines:

« If you include patient information, for patient confidentiality, use the Patient ID instead of the
patient’s name.
« If you include screenshots, ensure that you conceal both the patient’'s name and date-of-birth.

4 Fastpath:

For urgent problems or issues with using the portal, call 1800 798 441 to speak to a

support team member.

If reporting a problem, before contacting us, try to replicate the problem. It also helps to write down

the problem and the circumstances under which it occurred.

Release Notes

Release notes for all versions of Communicare are available on the Knowledge Centre.

To open the release notes for the latest version of Communicare:

1. On the Communicare User Portal > Help and Support https://communicare-
portal.telstrahealth.com/help-and-support/ tab, in the Knowledge Centre tile, click Learn
More.

2. In the Knowledge Centre https://communicare-portal.telstrahealth.com/knowledge/, from the

main menu, select Support > Release Notes > required release notes version.

e Tip:

Release notes for the latest version are listed first.

If you are using an older version of Communicare and want to refer to release notes for that version,
the release notes are included with the latest version. However, to display the Knowledge Centre for
your version of Communicare, in the Knowledge Centre, on the right side of the main menu, select

your version of Communicare.


https://communicare-portal.telstrahealth.com/
https://communicare-portal.telstrahealth.com/help-and-support/
https://www.bit.ly/communicarehelp
https://communicare-portal.telstrahealth.com/help-and-support/
https://communicare-portal.telstrahealth.com/knowledge/
https://communicare-portal.telstrahealth.com/knowledge/
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Quick links to release notes

* Version 21.x:
°V21.3
o V21.2
o V21.1

* Version 20.x
> V20.2
> V20.1

* Version 19.x
°V19.2
> V19.1

« Older versions

Training

If you want someone to teach you how to use Communicare, from beginners to advanced users, try
our training.

We can organise someone to come to you, or you can access our eLearning.

6 Tip:

Check our eLearning site regularly for our invaluable Tips and Tricks.

Request Remote Assistance

Run Teamviewer for quick support or request remote assistance.

Requesting Remote Assistance will allow Communicare Support to have a live view of your screen
so we can help you better.

To run remote assistance, when instructed by Communicare Support, in Communicare, select Help >
Request Remote Assistance.


https://communicare-portal.telstrahealth.com/knowledge/V21.3/topics/release_notesV21.3.html
https://communicare-portal.telstrahealth.com/knowledge/V21.2/topics/release_notesV21.2.html
https://communicare-portal.telstrahealth.com/knowledge/V21.1/topics/release_notesV21.1.html
https://communicare-portal.telstrahealth.com/knowledge/V20.2/topics/release_notes.html
https://communicare-portal.telstrahealth.com/knowledge/V21.2/topics/Version_20_1.html
https://communicare-portal.telstrahealth.com/knowledge/V21.2/topics/Version_19_2.html
http://portal.telstrahealth.com/knowledge/V21.2/topics/Version_19_1.html
http://portal.telstrahealth.com/knowledge/V21.2/topics/Release_Notes_old.html
https://communicare-portal.telstrahealth.com/contact/
http://communicareusers-telstrahealth.talentlms.com/
https://communicare-portal.telstrahealth.com/training/
https://www.bit.ly/communicarehelp
https://www.bit.ly/communicarehelp

In order to invoke Request Remote Assistance, on your keyboard, press CTRL+F2.



Glossary

Glossary

Active medication

For prescribed regular medications, medications that are not expired, stopped or deleted.

Administer

The act of applying a medication directly to a patient. For example, when a nurse gives a patient an

injection.

Administrative Encounter Place

A group of encounter places defined for administrative or reporting purposes.

AIR Encounter

A visit to a vaccination provider where one or more episodes (vaccines) are administered to the
patient.

AIR Episode

The actual immunisation provided to the patient, by the vaccination provider. An AIR Encounter must

have a minimum of one episode, and a maximum of five episodes.

Biographics

General information about a patient, such as names, addresses, Medicare Number, and so on.

Class

A group of clinical item types that have common properties and attributes or data values.

Clinical item

A record of any event on a patient record, either actual or a planned recall, such as a disease,
immunisation, procedure, medication prescribed, and so on. Clinical ltems in Communicare are
coded according to ICPC-2 PLUS.

Clinical item keywords

Specific words that can be used to locate Clinical Item types.



Consolidated order

Groups of medication requests used to order medications from an external pharmacy and to

manage patient-specific inventory.

DAA

Dose Administration Aid (DAA) is the term used for packaging that organises doses of medication

according to when they should be taken.

Dataset

A collection of related clinical item types, qualifiers and recall types.

Encounter

A meeting between a health provider and a patient.

Encounter mode

Either the means of delivering a health service, for example Telephone; or the type of physical place
at which a health service is delivered, for example, School.

Encounter place

Either a Service Encounter Place, where patient contacts occur; or an Administrative Encounter
Place, a concept that defines a group of encounter places for administrative or reporting purposes.
The Service Encounter Place is the physical place at which a service is delivered, or the physical
place from which a service is delivered, for example, Millennium Health Service Clinic. Each place is

categorised into one or more Modes.

Episode

When a condition is diagnosed it may be classified as a FIRST, NEW, or ONGOING episode.

Health Centre Prescribing

Health Centre Prescribing (HCP) or Rural Prescribing is a workflow used in the NT, where instead of

PBS scripts, a single consolidated script is printed for all regular medications for a patient.

Immunisation Provider

The provider who administered a vaccine to an individual.



Last consolidated order date

For the encounter place, the most recent date at which a consolidated order was ordered.

LEMI

From Active Ingredient Prescribing legislation, a list of excluded medicinal items (LEMI) for which
Communicare does not include the generic components. The LEMI includes non-medicinal items

such as bandages, or medications with four or more active ingredients.

LMBC

From Active Ingredient Prescribing legislation, a list of medicines for brand consideration (LMBC),
for which providers should consider prescribing by brand. For example, medications that are not
bioequivalent.

Locality

A list of places used in patient addresses. Initial localities are taken from Australia Post localities,

but additional localities may be defined, for example, for a local community.

Locality group

Where several localities are combined for reporting purposes. For example, Northern Region, South

of River, Inner City, and so on.

Medication request

Medication requests combine a patient's medications into a bulk-order prescription for sending to a

pharmacy for dispensing.

Medication summary

A list of a patient's currently active medications.

Mode

See Encounter mode (on page 23).

National Cancer Screening Register

Communicare integrates with the National Cancer Screening Register (NCSR).



Once off medication

A medication typically prescribed for acute clinical presentations, which the patient will take until
the course is complete. Once off medications are removed from the Medication Summary after their

duration has elapsed. Once off medications may also be described as Short Course medications.

Place

See Encounter place (on page 23).

Provider

Anyone who provides health care for a patient, such as a doctor, health worker, nurse, and so on.

Qualifier

A measurement associated with a Clinical Item

Query

An instruction to retrieve statistics from the database.

Regular medication

A medication typically prescribed for a chronic disease, which the patient would be expected to take
continually. Regular medications are displayed on the Medication Summary until they are explicitly

stopped.

Report

The results of a query about data in the database.

Service recording

A record of a patient's services, such as clinic visits, home visits or other.

Supply

The act of providing medication to a patient or their carer.

Topic

A grouping of Clinical Items into health or medical-related categories.



Vaccine Provider

A medical practitioner or person who is recognised by Services Australia as being a provider of

vaccinations to individuals, according to the Australian Immunisation Register Act 2015.

Walk-in patient

Patients who arrive without an appointment.
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Notices

If using the Australian Immunisation Register integration: Participating health professionals may
utilise the services and information provided including personal information only in accordance with
National (Privacy Act 1988, Health Insurance Act 1973, Australian Immunisation Register Act 2015
and other relevant legislation), State or Territory legislation, Policy and Guidelines.
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